
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This tutorial has been devised to show what can be achieved with just the basic 
drawing facilities in Word. Whether you want to enhance manuals, create 
simple brochures, it can all be done with the Draw Toolbar facilities. Even if 
you think you cannot draw, try it, you will be amazed at what can be achieved 
using pre-created shapes and the facilities available. With patience, you can 
create the most complex diagrams by simply reducing them to small 
components. 
 
This whole document has been produced using just the features available on the 
Draw Toolbar plus the standard screen grab facility available in Windows. 
 

No part of this document may be copied or 
incorporated into other works without the 
written permission of the author 

by Keith Howell 
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If you do not have it already displayed, show the 
Drawing Toolbar by selecting View/Toolbars/Drawing 
 

Select Objects 

Free Rotate 

Line 

Arrows 

Rectangle 

Oval 

Text Box 

Insert WordArt 

Insert Clip Art 

Fill Colour 

Line Colour 

Font Colour 

Line Style 

Dash Style 

Arrow Style 

Shadow 

3-D 



 3 ÓÓÓÓKeith Howell 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The cursor will change to a cross  
 
Position the “cross” cursor on your 
page where you want your line to 
start. Hold down the left mouse 
button & drag the cursor in the 
direction you want your line. Let go 
the mouse button at the length you 
want the line to be. 

Tutorial 1  

Click on the Line tool 

TIP – If you hold the shift key down while you 
drag out the line it will snap to the nearest 15°°°° 
angle. For example, if you want a perfectly 
vertical line, hold the shift key down and drag 
out your line to as near as vertical as you can 
and it will snap to the vertical 

Make another line anywhere on the page  

Now we are going to alter our first line. Position 
the cursor over it (the cursor will change to a 
pointer with a cross under it). Holding down the 
left mouse button on the line, drag the line to a 
new location and let go. 
 
Click on the line again, the line becomes the 
active object and anchors (squares) are displayed 
at either end. Click on one of the end squares 
(anchor points) and drag it to a new position 
 
 
You have now learned how to create lines, 
reposition them and change their direction and 
length. 
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Exercise 1 

Draw a vertical line (if the anchor points are not showing, 
click on it to show them) 
 
Press Ctrl C and then Ctrl V to copy and paste a duplicate 
line (if you are more comfortable using the Edit pull down 
menu to copy and paste then do it that way) 
 
Click on the copy line and move it up so that it is at the right 
of the first line 
 
Hold the Shift key down and click on the first line. You 
should not have the anchor points showing at the end of both 
lines 
 
Press Ctrl C and Ctrl V to copy the pair and move the copied 
lines such that they are all level. 
 
With them all selected, pull up Draw/Align or 
Distribute/Align Top 

TIP – If you select an extra object, or miss one, 
hold the shift key down and click on the extra or 
missing one to deselect or select it 

Select the Draw pointer 

and drag it over all 4 lines to highlight all of them 

Also note that if you need to change a component in a “group” 
that you have created, you will need to “UnGroup” your group 
to get at it 

stretched or squeezed just 
like an individual item. 

Note that if you select 
the group now, you get 
anchor points that 
reflect the group, NOT 
the individual lines. 
 
The group can be  

Pull up the Draw 
menu and select 
“Group”  
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Select the copy group, pull 
up the Draw menu and select  
Rotate or Flip/Rotate right 

Exercise 1 - continued 

Select the group of 4 lines and use Ctrl C, Ctrl V to make 
another copy of it (or Edit Menu/Copy, Paste) 

Select the Draw pointer. Move the rotated group on top of the 
original group of 4 vertical lines to make your grid. 
 
You may need to squeeze or stretch either your vertical group 
or your horizontal group to get them to line up exactly.  You 
may even need to adjust an individual line but remember – 
you will have to “UnGroup” to get at it 

4 green anchor points will appear. 
 
Position the cursor over one of these 
green corner points and experiment 
dragging it in different directions. 
Notice how the group rotates 

Select both the vertical group and the horizontal group and 
group these two groups into one. Note that if you wanted to get 
at an individual line now, you would have to select “UnGroup” 
twice. 

Select the “Free rotate” tool 

Once you have chosen your new angle, click on the 
Draw cursor to release the free rotate option. 
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Tutorial 2  

Arrows are no more than lines with special ends on. You can stretch them, 
move them, swing them about, change their colour and thickness just the same 
as you learned to do with lines. So here we will just look at how to choose and 
change the arrow styles 

Click on the Arrow  tool and draw a line. 

Click on the Arrows Style tool to get the 
selection of end types 

Click on the style you want, double or single 
ended, open or closed arrow. If you are not happy 
with this choice then click on More Arrows 

Select the end style you 
want, its size, colour and 
any other parameter on 
offer and click OK 
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The cursor will change to a cross  
 
Position the “cross” cursor on your page where 
you want the top left corner of your rectangle 
to start. Holding down the left mouse button, 
drag the cursor to the bottom right corner of 
your rectangle. Like any drawn object, a 
rectangle can be dragged to another location 

Tutorial 3  

Click on the Rectangle tool 

TIP – If you hold the shift key down while you 
drag out the rectangle, it will force a square 

TIP – You can alter the shape of the rectangle 
by dragging any of its anchor points (remember 
to hold down the shift key if you are resizing a 
square). 

Click to show the 
Fill Color options 

Click on Red 
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Draw another rectangle slightly over the first 
one.  
 
 
Alter the Fill Colour to match the background 
colour of your page (in your case probably 
white, on this drawing it is the lightest grey. 
 
 
 
Alter the Line Colour to match the background. 
This shows how we can use shapes of 
background colour to eat into other shapes 

Tutorial 3 - continued 

Click to show the 
Line Color options 

Click on Yellow 

You have now learned how to create rectangles 
(squares), colour them, move them and reshape 
them. You have also learned how to use shapes 
to hide bits of unwanted drawing  

For example, the diagram at the top of the 
previous page is a rectangle and a cross overlayed 
with two small rectangles of background colour 
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Using what you have already learned, create a red 
rectangle. 
 
 
Create a blue circle, slightly over the top of the red 
rectangle. 

Tutorial 4  

Word keeps a note of the order in which you draw 
objects. It helps if you imagine them existing on 
layers. You can then use the concept to help in 
your drawings  

Draw a horizontal line over the top of the first 2 
objects. Make the line 3pt thick 

and colour it yellow 

Note – “Bring forward” and “Send backward” moves the 
object one layer at a time. If you have drawn other objects 
on the page, they may interfere with the positioning. 

Click on the line then select “Send to 
back” from the Draw/Order menu 
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This is probably the most difficult thing to master in 
the whole tutorial so if you can crack this everything 
else is down to remembering what tool does what. 

Tutorial 5  

Click on the Autoshapes/Lines/Curve 

Just like any other drawn object, bendy 
lines can be resized by clicking on them 
and dragging the displayed anchor points 
to a new position.  

Once again the cursor changes to a 
cross. Position it where you want to 
start your bendy line, click then move 
the cursor out to the first part of your 
bend. Click the left mouse button at 
this point and then move the cursor to 
the next turning point. Click here and 
move the cursor to the next point. 
Repeat this process for as many 
different bends as you want. Press the 
ESC key when you want to finish 
your line 
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You may not be entirely happy with your bends. 
Don’t worry – we can alter them. 

Tutorial 5 - continued 

Click on Draw/Edit points 

The system highlights the points you chose 
to define your bends. We can drag these to 
modify or fine tune our bend. Position the 
cursor over any of the points and drag it to a 
new location. 

More importantly, if we position the 
cursor over one of these points and 
press the RIGHT mouse key, we get a 
whole selection of options. We will just 
deal with adding and deleting points 
here and cover the remainder later 

At this point, you should try drawing a 
few curves until you are happy you can get 
pretty much the bends you want. Then edit 
the points to fine tune the over all shape. 

BORED YET ?– it’s time to draw something 
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The cursor will change to a cross.  
 
Position the “cross” cursor on your page where you 
want the top left corner of your Text Box to start. 
Holding down the left mouse button, drag the 
cursor to the bottom right corner of your Text Box. 

Tutorial 6  

Click on the Text Box tool 

If you want to add a colour background or a box 
outline colour use the fill colour and line colour 
tools. 

Type your text. Keep typing so that you have more 
text that can fit in the box and see what happens. 
(You have all the typing facilities you have on a 
normal Word page). 

Grab any of the anchor points and stretch the box 
until you can see all of the text you have typed. 

Our text 

If you want to colour the typed text use the font 
colour tool 

Coloured text 

TIP – If you choose No Fill in the Fill Colour 
tool & No Line in the Line Colour tool you can 
overlay your text on top of other drawn objects 
without the backgound colour or box outline 
interfering with your drawing 

Coloured text 

Our text To reposition a Text Box, position the cursor 
onto the edge of the box - the cursor changes to 
a        symbol. Drag the box to its new location. 
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 Tutorial 7  

Exercise 2 

Click on the Ellipse  tool and holding the shift key 
down, drag out a circle (see Tip 1 in Exercise 2) 

Click on the Text Box tool and drag out a text box. 
Type a 2 and, holding the left mouse button down, 
drag the cursor over it to block it out. 

Use the Font Colour tool to change the 2 to red 
and, using the main Word tool boxes, select Arial 
font, 20 point and Bold 

Select No Fill and No Line for the Text Box and 
position the cursor on the border and drag it over 
your Circle. Hold down the shift key and click on 
the circle so that both the circle and the text box 
are selected. Select the Draw menu and Group to 
group both together. Use Ctrl C, Ctrl V  to make a 
duplicate (or Edit/Copy ; Edit/Paste) 

Block out the 2 and type 35. If you cannot see 
the 5 as in this example, you will need to use 
the Draw menu/Ungroup to free up the text box 
so that you can reshape it to get the 3 & 5 on 
one line. 

Click on Line Density tool and select 2� pt 

35 

Drag the reshaped text box to reposition the 
numbers centrally in the circle. Select both the 
circle and text box and use Draw menu/Group to 
loc them together again. 
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1. Type your text in a text box  
and select no fill and no line 

 

2. Copy the Text Box and ‘Paste 
Special’ as a picture. Don’t 
worry about where it gets 
pasted, just click on it to 
expose the picture boundary 

We want to rotate this 

3. Now click on Text Wrapping in 
Format Picture toolbox and select 
Behind Text 

4. Our picture is now a graphic 
object that has a rotation handle 
when selected 

You have to remember that the text 
is not editable, you will have to 
repeat the whole process if you need 
to alter it 

Tutorial 7  
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2. Now we have to draw a mask around it using 
the Autoshapes/Lines/Freeform tool. Just do 
one half as below. Note – try and get it as 
close as you can. I have exaggerated it to 
make it more obvious. Don’t forget you can 
use the edit points to improve the shape (see 
Let’s draw 5 – Drawing a wine glass) 

Exercise 3 

This exercise is with thanks to Mary Sauer 
(msauer.mvps.org) for pointing to the way forward 

Before we start, it is important to note that at this 
point in time, the text wrapping facilities in WORD 
cannot cope with filling what I call ”upward hollows” 

1. Either draw your own 
freeform shape or choose one 
from Autoshapes. For the 
purposes of this exercise we 
are going to use a heart 

3. Now copy the shape, flip it horizontally and move it into 
position so that the heart is enclosed. Finally, move your 
original heart out of the way and save it somewhere else 
on the page for the moment 
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Exercise 3 - continued 

4. Currently, WORD doesn’t support tight text wrap 
inside text boxes so here is Mary’s solution: Draw 
a 1 x 1 table and reshape the single cell to the size 
of your object. Then move your mask over the 
cell. Don’t forget you can drag the 1 cell table to 
anywhere on the screen 

  

5. It will make things easier if you fill the areas 
in which you don’t want text. So for the 
example of a heart, you can either add in two 
triangles or you can use the edit points to pull 
out the existing mask  

 

6. Remember, if you 
type too much in 
the cell it will 
automatically 
expand to take it.  

7. With some shapes you might wonder why  
the text is not close in some areas? Click 
on the left heart mask and pull down ‘edit 
wrap points’ to display the ‘wrapping’ 
contour. Manipulate the wrap points until 
you get the fit you want. 

8.   Finally, set the cell border to ‘none’ and the 
mask lines to ‘no-line’. Colour in your 
original shape and bring it ‘behind’ the text 
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Tutorial 8  

3. Make sure your shape is selected 
and click on the Fill Color tool 

1. Either draw your own shape or choose 
one from the Autoshapes selection 

e.g. 

or
e.g

2. Tutorial 3 covered solid fill colours and 
line colours. Here we are looking at some 
of the Fill Effects 

4. For the first example we will choose a single colour 
with vertical shading and because it is a cylinder 
we will choose dark at the outsides and set the dark 
to light slide fairly low to emphasise the curvature. 
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100 
102 
104 
106 
108 

Tutorial 8 - continued 

5. Perhaps we would like to use two colours.  

6. Select a level of transparency to let text or 
objects show through from behind.  
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Tutorial 8 - continued 

7. Experiment with choosing textures or patterns.  

Texture can e 
made to rotate 



 20 ÓÓÓÓKeith Howell 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tutorial 9  

1. Draw or select your shape 
(we are going to use an 
autoshape ‘Oval’ figure)  

2. Select Fill Color/Fill Effects and click on the Picture TAB. 
Browse for your picture and click on OK when you have the 
one you want 

And finally you have your 
picture inside the shape you 
have chosen.  
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We have 2 fundamental types of wrapping. The first is to wrap text around a 
picture or a graphic where the text is normal typed word processing text (in 
line) as in this paragraph. The second type is to wrap the text where we are 
using pictures and free floating text boxes (It currently cannot be done 
without an element of trickery – a solution provided by Mary Sauer) 
 
Firstly, pictures in line. 
 
This is text is here to allow us to experiment with a picture and see what 
happens when we play around with wrapping styles and resizing. This is text 
is here to allow us to experiment with a picture and see what happens when 
we play around with wrapping styles and resizing.  

This is text is here to allow us to experiment with a picture and see what 

happens when we play around with wrapping styles and resizing.  

Tutorial 10 

1. Position the cursor in your 
text where you want your 
picture to appear 

2. Select the picture you want 
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and see what happens when we play around with wrapping styles and 
resizing. This is text is here to allow us to 
experiment with a picture and see what happens 
when we play around with wrapping styles and 
resizing. This is text is here to allow us to 
experiment with a picture and see what happens 
when we play around with wrapping styles and 
resizing. This is text is here to allow us to see what 
happens when we play with wrapping styles and 
resizing. This is text is here to allow us to 
experiment with a picture and see what happens 
with different wrapping and resizing. This is text  to experiment with. 

Tutorial 10 - continued 
3. With the picture selected, select Format Picture from the  

Picture toolbar and click the Layout tab and Advanced 

4. Select Tight wrapping and 
Wrap Text Both Sides 

5. Select Horizontal Alignment Right to 
put picture on right of your text 



 23 ÓÓÓÓKeith Howell 
 
 

 
 
 
 
 

This is text is here to allow us to experiment with a picture and see what 
happens when we play around with wrapping styles 
and resizing. This is text is here to allow us to 
experiment with a picture and see what happens when 
we play around with wrapping styles and resizing. This 
is text is here to allow us to experiment with a picture 
and see what happens when we play around with 
wrapping styles and resizing. This is text is here to 
allow us to experiment with a picture and see what 
happens when we play around with wrapping styles 
and resizing. This is text is here to allow us to 
experiment with a picture and see what happens when we play around with 
wrapping styles and resizing.  
 
This is text is here to allow us to experiment with a picture and see what 
happens when we play around with wrapping styles and resizing. This is text 
is here to allow us to experiment with a picture and see 
what happens when we play around with 
wrapping styles and resizing. This is 
text is here to allow us to 
experiment with a picture and 
see what happens when we 
play around with wrapping styles 
and resizing. This is text is here to allow us 
to experiment with a picture and see what happens 
when we play around with wrapping styles and resizing.  

 
This is text is here to allow us to experiment with a picture and see what 
happens when we play around with wrapping styles and resizing. This is text 
is here to allow us to experiment with a picture and see what happens when 
we play around with wrapping styles and resizing. This is text is here to allow 
us to experiment with a picture and see what happens when we play around 
with wrapping styles and resizing. This is text is here to allow us to 
experiment with a picture and see what happens when we play around with 
wrapping styles and resizing. This is text is here to allow us to experiment 
with a picture and see what happens when we play around with wrapping 
styles and resizing. This is text is here to allow us to experiment with a picture 
and see what happens when we play around with wrapping styles and resizing. 
This is text is here to allow us to experiment with a picture and see what 
happens when we play around with wrapping styles and resizing. 

 

6. Highlight this paragraph and select Justify 
to straighten the border next to the picture  

7. Here we have chosen a 
picture within a shape and 
moved it into the middle  

8. Here we have chosen Format 
Picture/Layout 
Tab/Wrapping style ‘Behind 
Text’ and Picture Tab/Image 
Control Color = ‘Washout’ 

Tutorial 10 - continued 
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Now is the time for all good 
men to come to the aid of 

the party. Now is the 
time for all good men 
to come to the aid of 
the party.  Now is the 

time for all good men to 
come to the aid of the party. 

Now is the time for all good men to come to the aid of the party. 

Because WORD cannot cope with wrapping text in text boxes, if we want to 
achieve the same effect we have to create a 1 cell table (with no border). We 
add our picture into the cell and, in this example, set its wrapping to tight and 
right side only.  If we want a picture shape other than a rectangle then insert 
your shape e.g. an ellipse and set up its wrapping then use the Fill color/Fill 
effects/Picture option to add in your picture. 
 
You can now position your 1 cell table around your document to your desired 
location. 
 
Don’t forget to set the cell and table border to None otherwise you get a 
rectangle printed around your work. 

Tutorial 10 - continued 

Wrapping text box text around pictures 
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Tutorial 11 

To achieve this we use the WordArt facilities 
and will use just one of the font styles (once 
you have learned the following, you will be 

able to explore the other styles) 

1. Click on the Insert WordArt Tool to open the 
choice of styles. We are going to use the 3rd. 
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Tutorial 11 - continued 

Having made your choice you will be presented with 
the font edit box where you must type your text. 

Squeeze the sides in 

Pull the bottom down  to 
increase the height 

Pull the text round by 
dragging the yellow 
marker 

Add Autoshapes / 
Basic shapes/Donut 
and stretch it to fit 
behind your text 

Add a circle and fill 
it with a picture or 
drawing 

Type your text e.g. ‘Good graphics are powerful’ and click on OK 
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Tutorial 12 

1. Draw a closed shape or select one from 
Autoshapes/Basic shapes and, with your 
shape selected, click on the Shadow tool 

2. Select the type of 
shadow you want  

3. Use these 4 to alter 
the position and 
depth of the shadow 

4. Use this to pull 
down and select 
the colour of your 
shadow 

5. Finally, if you want, use this or the 
transparency setting in More Shadow 
Colours to render the shadow with a 
level of transparency 
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Tutorial 13 

1. Draw a closed shape or select one from 
Autoshapes/Basic shapes and, with your 
shape selected, click on the 3D Style tool 

2. Select the type of 3D  
effect you want  

3. Use these 4 to alter 
the horizontal & 
vertical tilt of the 
3D effect 

5. Use this to alter the direction 
& strength of lighting 

4. Use these 2 to alter the 
depth and direction of 
your 3D effect 

6. Use this to 
choose the 
surface type 

7. Use this to 
choose the 
colour of the 
3D effect 

NB Use the normal 
Fill Color to 
colour the face 


